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Microsoft Word Basics

Getting Started XE "Getting Started" 
1.
Click Start
2.
Glide to Programs

3.
Find Microsoft Word and click.
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Getting Help XE "Getting Help." 
When first entering Word 2000, Clipit XE "Clipit"  (the Office Assistant) is ready to assist.  If you need help and the Office Assistant is not visible, you can:
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Click on the menu option, Help/Show the Office Assistant
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OR click on the question mark      on the toolbar 
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OR press F1.

To remove Clipit from the screen, right-mouse click on the Office Assistant, then click on Hide.
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When you first enter you have the Regional Application menu.
The one option that will probably concern you the most will be
the first Display.

The Display is in 3 categories:

Human Resource Management
Civilian Career Brief
and Personnel Processing

Under the Personnel Brogessing there is the Basic screen. On
the basic screen, T can input any SN and press F8 and the info
on that individual will appear.

Many things are automated here in the PPT program. I do think
that all supervisors should have access to their personnel that
work for them.




Customizing the Office Assistant XE "Customizing the Office Assistant" 
You can modify a number of Office Assistant settings that affect the way the Office Assistant offers tips.  

To open the Office Assistant Options XE "Office Assistant Options"  window, right-mouse click on the Office Assistant then click on Options.
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Below is a definition of each option.  Once you decide which options you want, click on the OK button.

	Office Assistant Options XE "Office Assistant Options" 

	ON by

Default
	Option
	Description

	X
	Use the Office Assistant
	Enables the Office Assistant so that it is available when you ask for assistance.

	X
	Respond to F1 key
	Enables the Office Assistant when you press the F1 key.

	X
	Help with wizards
	Enables the office Assistant help when you run a wizard.

	X
	Display alerts
	Enable the Office Assistant help when you are in standard dialog boxes.

	
	Search for both product and programming help when programming
	Searches for both programming and product Help topics while you work with Visual Basic for Applications in your program.



	X
	Move when in the way
	Allows the Office Assistant to move out of the way of other screen elements.

	X
	Guess Help topics 
	Lets the Office Assistant to guess at help topics based on the actions you have performed.

	X
	Makes sound
	Turns on the sound for the Office Assistant.

	X
	Using features more effectively
	Gives tips when it evaluates your actions and thinks you are not using Office features effectively.

	X
	Using the mouse more effectively
	Gives tips when it evaluates your mouse movements and thinks you are not using Office features effectively.

	
	Keyboard shortcuts
	Shows the keyboard shortcuts for procedures you carry out in the Office Assistant tips.

	
	Only show high priority tips
	Shows only the important tips such as time saving features.

	
	Show the Tip of the Day at startup
	The Office Assistant offers a general tip each time you start an Office program.

	
	Reset my tips
	Displays tips you have already seen.


If they are installed, you can even choose a different Office Assistant.  To choose a new Office Assistant, right-mouse click on the Office Assistant then click on Choose Assistant XE "Choose Assistant" .
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To scroll through the different assistants use the Back and Next buttons.  When you are finished selecting your assistant, click on the OK button.

Pull-down menus XE "Pull-down menus"  only show those items you use most often.  

· To view all commands for a particular menu, double-click on the Menu name

[image: image26.png]



OR

· Point at the double down arrow that appears at the bottom of the menu.  

The Standard and Formatting Toolbars XE "Standard and Formatting Toolbars"  share one row.  Click on the double-arrow to open the formatting toolbox.
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· To allow the Menus to show all items under them 

AND 

· To have the Standard and Formatting Toolbars not share the same row:

1.
Click on Tools/Customize to open the Customize Window.
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2.
Click on the Options Tab.

3.
Remove the checkmarks in the two blocks by clicking in each.

4.
Click on the Close Button.

Setting Defaults in MS Word to Reflect the 

Marine Corps Standard

Margins XE "Default Margins, the Marine Corps Standard" 
· Marine Corps Standard - 1 inch top/bottom/left/right

· MS Word Default – 1.25 inch left/right

· To change the default of the left/right margins:

1.
Click on File/Page Setup...

2.
Using the down arrow at the Left and Right Margin:
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Click 3 times to change it to 1” or just enter 1”.
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3.
Click on the Default... Button
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4.
Click Yes.

This change will make all new documents created with the Marine Corps Standards margins.  It will not affect documents that already exist. 

Font XE "Default Font, the Marine Corps Standard" 
· Marine Corps Standard – Courier New, 12 point

· MS Word Default – Times New Roman, 10 point

To change the default of the Font:

1.
Click on 
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Format/Font...

[image: image39.png]| Eile [ it

|0 6o UndocClear  cirkez

B: Cirlvy

Ei Clrl+F

Document3 - Microsoft Word HE B

View Insert Format Tools Table Window Help

Cirl
Cirfte

CirlvA

«

«lo]» |«

gl ,

Jomw- b &

sumshapes- N NCOJOE 48] & -£-A sEug.

[Page 1

Sec 1 FTT| T B e W= N ==l il S e

R Start

|| @ @@ | En.|®mw |®o @0 BE M CE® 259 PM




2.
With your cursor 

in the Font area start typing Courier

OR
Use the scroll bar
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to find 

Courier New.


3.
Change the Size, by clicking on the 12.
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Click on the Default button.
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5.
Click on Yes.
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This change will make all new documents created with the Marine Corps Standards font.  It will not affect documents that already exist. 

Please input the following paragraphs:

Changes in Microsoft Word 2000, a revised and updated version of the world’s most popular word processor, seem minimal at first.  The lastes Word sports the same pull-down menus and many of the familiar button-rich toolbars that users have come to know and aappreciate.

Overall, Word 2000’s strengths far outnumber its weaknesses.  For example, it are the only word processor that works really well with other Microsoft products.

After input:

Save XE "Save" 
1.
Click File/Save 
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OR 
Click on the diskette      icon
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OR 
Press Ctrl S. 
2.
First time saving, the Save As window opens with the first line of text in the File name.  You have opportunity to change the Save in folder and the File name.  

3.
Click the Save button.

NOTE: If you have saved the document before, there will be no hesitation in saving.  Your cursor will remain in the same position as before saving.

Print XE "Print" 
· Find the Printer 

 icon on the Toolbar. It automatically goes to the printer.

· For printer options, open the Print window by:

Clicking on the File menu, then click on Print
OR 

Press Ctrl P.
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The following table describes the options available in the Print window:

	Option
	Description

	Name
	Lists the default Windows printer.  If available, you can select another printer.

	Properties
	Opens the default printer properties window where you can specify the paper size, orientation, and paper source.

	Print to file
	Allows you to print the document to a file or disk.  Word prompts you to enter the name of the file.

	Page range
	Allows you to print All (an entire document), the Current page or Pages (a range of pages).  To print a range of pages, enter the page range in the Pages box.  Separate individual page numbers by commas and ranges by a hyphen (-) in the following format:  1,4,8-10.  If you have selected text to print, Word displays the Selection option.

	Copies
	Allows you to set the Number of copies you want to print.

	Collate
	Allows you to print a complete range of pages before printing the next copy.  Word prints one copy of each page before starting over.

	Print what
	Allows you to indicate what you want to print:  Document, Document properties, Comments, Styles, AutoText entries, or Key assignments.

	Print
	Allows you to choose to print All pages in range, Odd pages, or Even pages.

	Zoom
	Pages per sheet allows you to indicate how many pages you want on one sheet and Scale to paper size allows you to indicate a paper size you want the document to be scaled to.

	Options
	Opens the Print dialog box so you can select various printing options.  You can also select the Tools menu click Options and the Print tab to change the same printing options.


Open an Existing File XE "Open an Existing File" 
Click on the File Menu and Word displays the names of the four most recently used documents on the bottom of that menu.  If you want to open one of these documents, click on its name.  Otherwise:
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1.
Click File/Open or click on the folder      icon.

2.
Click on the name of the File.  For the purpose of this class open the document Lab for Word.

3.
Click Open.

	Using the Keyboard to Move Through Your Document XE "Using the Keyboard to Move Through Your Document" 

	Key(s)
	Movement

	Ctrl/left arrow
	Moves the insertion point one word to the left.

	Ctrl/right arrow
	Moves the insertion point one word to the right.

	Home
	Moves the insertion point to the beginning of the line.

	End
	Moves the insertion point to the end of the line.

	Ctrl/up arrow
	Moves the insertion point up one paragraph.

	Ctrl/down arrow
	Moves the insertion point down one paragraph.

	Page Up
	Moves the insertion point up one screen.

	Page Down
	Moves the insertion point down one screen.

	Ctrl/Page Up
	Moves the insertion point to the top of the previous page.

	Ctrl/Page Down
	Moves the insertion point to the top of the next page.

	Ctrl/Home
	Moves the insertion point to the beginning of the document.

	Ctrl/End
	Moves the insertion point to the end of the document.
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Different Ways to View a Word Document XE "Different Ways to View a Word Document" 
· To switch views, click on the View Menu and click on Normal, Web Layout, Print Layout, or Outline.  

OR 

· Click on the icon that represents that view in the lower left corner.

Work in Normal View XE "Normal View"  for typing, editing, and formatting text. Normal view shows text formatting but simplifies the layout of the page so that you can type and edit quickly. In normal view, page boundaries, headers and footers, backgrounds, drawing objects, and pictures that do not have the In line with text wrapping style do not appear.

Work in Web Layout View XE "Web Layout View"  when you are creating a Web page or a document that is viewed on the screen. In Web layout view, you can see backgrounds, text is wrapped to fit the window, and graphics are positioned just as they are in a Web browser.

Work in Print Layout View XE "Print Layout View"  to see how text, graphics, and other elements will be positioned on the printed page. This view is useful for editing headers and footers, for adjusting margins, and for working with columns and drawing objects.
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Work in Outline View XE "Outline View"  to look at the structure of a document and to move, copy, and reorganize text by dragging headings. In outline view, you can collapse a document to see only the main headings, or you can expand it to see all headings and even body text. Outline view also makes it easy to work with master documents. A master document makes it easier to organize and maintain a long document, such as a multipart report or a book with chapters. In outline view, page boundaries, headers and footers, graphics, and backgrounds do not appear.

Zoom In or Out of a Document XE "Zoom In or Out of a Document" 
You can "zoom in" to get a close-up view of your document or "zoom out" to see more of the page at a reduced size. 

Click on the View menu then click on Zoom.
OR
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1.
Click the arrow next to the Zoom box.

2.
Click the zoom setting you want. 

Print Preview XE "Print Preview" 
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Another way to view a document is Print Preview; you can display multiple pages of a document in a reduced size. In this view, you can see page breaks, hidden text, and watermarks, and you can make editing or formatting changes before you print the document.  To switch to print preview, click the Print Preview       icon on the Standard toolbar.

Here is a definition of each Print Preview icon:

	Print Preview
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	To print one copy of a document from within print Preview, click the Printer button.
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	Click on the Magnifier button to edit your document in Print Preview.
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	After viewing multiple pages, click the One Page button to switch back to single-page.
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	Click on Multiple Pages button to view up to 24 thumbnail pages.  Select the number of pages you want to appear by dragging the mouse across the selection grid.
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	While viewing the document in Print Preview, the mouse pointer becomes a magnifying glass with a plus symbol.  To zoom the document to full size, move the pointer to the region of the page and click.  You can adjust the exact proportion of the text by entering a new percentage in the Zoom box.
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	To see the horizontal and vertical rulers, click the View Ruler button.
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	Click on the Shrink to Fit button to reduce the document by one page.  Use caution—it can shrink more than you are wanting!
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	To make your text area appear a little bigger by hiding screen elements, click on the Full Screen button.  To return click on the Close Full Screen button.
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	Click on Close to return to the view of the document you were using before you selected Print Preview.
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	Click on the Context Sensitive Help button and your mouse pointer becomes a ?.  Click on whatever you are interested in and Word displays an explanation.


Spell Checking XE "Spell Checking" 
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When you first enter you have the Regional Application menu.
The one option that will probably concern you the most will be
the first Display.

The Display is in 3 categories:

Human Resource Management
Civilian Career Brief
and Personnel Processing

Under the Personnel Brogessing there is the Basic screen. On
the basic screen, T can input any SN and press F8 and the info
on that individual will appear.

Many things are automated here in the PPT program. I do think
that all supervisors should have access to their personnel that
work for them.
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To check spelling and grammar:

Click the Spelling and Grammar icon and Word goes through the whole document stopping at any spelling or grammar errors.

The following table describes the options available in the Spelling and Grammar: English (U.S.) window XE "Spelling and Grammar\: English (U.S.) window" :

	  Choice
	Action

	Ignore
	Leaves the highlighted error unchanged and finds the next misspelling or grammar error.  This button changes to Resume if you click in the document to edit the document.  Click Resume to continue checking the spelling and grammar.

	Ignore All
	Leaves all instances of the highlighted error unchanged throughout the document and continues to check the document.  Word will ignore the spelling error or type of grammar error throughout the rest of the current Word session.

	Add
	Adds the highlighted word in the Not in Dictionary box to the custom dictionary.  (Click Options change the active custom dictionary.)

	Change
	Click Change to accept the current selection in the Suggestions box, or edit the text in the box and then click Change.  When the selected error is a repeated word, this button changes to Delete so you can easily remove the second instance of the word.

	Change All
	Click Change All to change all instances of the word in the Not in dictionary or Capitalization box to the word in the Suggestions box, or edit the text in the box and then click Change All.  Word changes all instances of the error in the active document only.

	AutoCorrect
	Adds the spelling error and its correction to the AutoCorrect list so that Word will correct it automatically as you type.

	Options
	Opens the Spelling & Grammar Options dialog box, where you can open a different custom dictionary or change the rules that Word uses to check spelling and grammar.

	Undo
	Reverses the most recent spelling and grammar check actions, one at a time.

	Close
	Closes this window, but does not reverse any changes you have made.  The name of the Cancel button changes to Close after you make a change in the document.
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OR

To check Spelling and Grammar individually, Right-Click on the words with red squiggly underlines for spelling choices and green squiggle underlines for grammar choices.  
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Thesaurus XE "Thesaurus" 
When you have overused a word or would prefer using something else, the Thesaurus provides a tool that you can find synonyms.  With your cursor on the word: 

1.
Hold the Shift key and press F7.
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2.
You will then have the option to Replace, Look Up, or Cancel.

OR
Right-Click on the word then click on Synonyms.

Selecting Text XE "Selecting Text" 
Select Text to change the attributes such as:

	Font
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	Size
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Selections are also made to Copy or Cut/Move.

	Selecting Text by Using the Keyboard XE "Selecting by Using the Keyboard" 

	Select one character at a time
	Shift+ Right or Left Arrow

	Select one word
	Shift+Ctrl+Right or Left Arrow

	Select entire line
	Shift+End

	Select from cursor to the top of the document
	Ctrl+Shift+Home

	Select from cursor to the bottom of the document
	Ctrl+Shift+End

	Select entire document
	Ctrl+A


	Selecting Text by Using the Mouse XE "Selecting by Using the Mouse" 

	Select one word
	Double Click

	Select entire line
	Click on the left margin

	Select entire sentence
	Press and hold the Ctrl key, click inside the sentence

	Select entire paragraph
	Triple-click in the paragraph

	Select entire document
	Triple-click in the left margin


Selecting Text Using the Selection Bar
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To select Text using the selection bar, use the following steps:

1.
Move the mouse pointer into the vertical area along the left edge of the text area.  When the mouse pointer enters the selection bar, it changes into an arrow pointing upward and right.

2.
Select the amount of text you want using any of the options below:

	Selecting Text Using the Selection Bar XE "Selecting Text Using the Selection Bar" 

	Selection
	Procedure

	Line of text
	With the mouse pointer in the selection bar, point to the line of text and click.  To select multiple lines, drag the mouse pointer next to the lines you want to select.

	Paragraph
	With the mouse pointer in the selection bar, point to the paragraph and double-click.  To select multiple paragraphs, drag the mouse pointer in the selection bar next to the paragraphs you want to select.

	Document
	With the mouse pointer in the selection bar, triple-click, or hold down the Ctrl key and click once.


More Ways to Select Text XE "More Ways to Select Text" 
· [image: image59.png]


Moving the insertion point to the beginning of the text you want to select, pressing the F8 key to enter Extend mode. And then pressing the arrow keys to extend the selection.  To cancel Extend mode, press the Esc key.  Word exits Extend mode but leave the select text highlighted.

· Moving the insertion point to the beginning of the text you want to select, pressing and holding the Shift key, and then pressing any of the arrow keys to select the text between the insertion point and the navigation key destination.  For example, if the insertion point rest in the middle of a sentence and you hold down the Shift key and press the End key, the entire text between the insertion point and the end of the line will be selected.

· Selecting Select All from the Edit menu or by pressing Ctrl/A keys.  This method selects all the text in the document.

Copying Text XE "Copying Text" 
If you want the same text to appear in different parts of your document or in another document, Word lets you copy text and insert it where you need it, leaving the original intact.

To copy text, use the following steps:

1.
Select the text you want to copy.

2.
Right-click on the selected text and click on Copy
OR


Press Ctrl/C keys to copy


OR
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Click on the Copy smart icon. 

3.
Go to where you want to place the text and right-click and click on Paste.

OR

Press Ctrl/V to Paste

OR
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Click on the Paste smart icon. 

Word pastes the text in the new location.

Using Multiple Clips on the Clipboard XE "Multiple Clips on the Clipboard" 
Up to a maximum of 12 items can be put on the Clipboard, you can paste the items individually or all items together by selecting Paste All.
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On the View menu, point to Toolbars, and then click Clipboard. 
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If the Clipboard toolbar is docked on your toolbar, click Items. 

To view the first 50 characters of text in an item on the Office Clipboard, rest the mouse pointer on the item's icon. If the item is a drawing object or picture, or an item that doesn't contain text, Microsoft Word displays a label such as "Picture 2," whose number indicates the order in which the item was copied. Note that the numbered labels of drawing objects and pictures indicate the copy order of drawing objects and pictures only; the numbered labels of items that don't contain text indicate the copy order of all items.

Moving Text XE "Moving Text" 
Word allows you to move text by taking it from its original location and placing it in a new location in the same or in another document.  The text no longer appears in its original position. 

To move text, use the following steps:

1.
Select the text you want to move.

2.
Right-click on the selected text and click on Cut.

OR


Press Ctrl/X keys to cut


OR
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Click on the Cut smart icon. 

3.
Go to where you want to place the text and right-click and click on Paste.

OR

Press Ctrl/V to Paste


OR
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Click on the Paste smart icon.

Word pastes the text in the new location.

Deleting Text XE "Deleting Text" 
To delete text to the right of the cursor, press the Delete Key.  Pressing Ctrl and Delete at the beginning of a word, will remove the word.

To delete text to the left of the cursor, press the Backspace key. Pressing Ctrl and Backspace at the end of a word, will remove the word.

Undo Mistakes XE "Undo Mistakes" 
When you have done something that you wish you hadn’t:


Click Edit/Undo 
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OR
Click on the left curved blue arrow icon.

To Undo several actions, click on the ( beside the blue arrow to view, then click on the earliest action on the list that you want to undo.  It will undo all of the actions above.  You cannot pick and choose.  

Redo Actions XE "Redo Actions" 
When you have undone something that you really wanted done:


Click Edit/Redo 
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OR
Click on the right curved blue arrow icon.

To Redo several actions, click on the ( beside the blue arrow to view, then click on the earliest action on the list that you want to redo.  It will redo all of the actions above.  You cannot pick and choose.  

Using the Previous/Next Page Buttons XE "Using the Previous/Next Page Buttons" 
In the bottom right—hand corner of your screen, click on these buttons to go to the Previous Page or to the Next Page of your document.
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Using the Go To Feature XE "Using the Go To Feature" 
Here are four ways to display the Find and Replace dialog box with the Go To tab displayed:

1.
Click on the Edit menu and click on Go To.

2.
Press the F5 Key.

3.
Press the Ctrl/G keys.
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4.
OR double click in this area at the bottom of your screen.
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You can also display the Find and Replace dialog box with the Go To tab displayed by clicking on the Select Brows Object button, which is the button in between the Previous Page and Next Page button on the vertical scroll bar on the bottom right-hand corner of your screen.

	Options from the Go To Tab on the 

Find and Replace dialog box:

	Option
	Description

	Go to what
	Lets you specify the type of location to which you want to go.

	Enter {selected go to what option} Name/Number:
	Lets you specify the particular location based on the selection you made in the Go to what list.  For instance, to move to page 4, select Page from the Go to what list and then enter 4 in the Enter page number box.  You can enter a + or a – to move forward or back the specified number of pages, sections, lines, etc.

	Go To
	Goes to the item specified under Go to what and Enter {selected go to what option}.  If the box is empty, Word displays Next instead of Go To.

	Next
	Goes to the next occurrence of the item selected under Go to what.  This option is available only if the Enter {selected go to what option} box is empty.

	Previous
	Goes to the previous occurrence of the item selected under Go to what.  This option is only available if the Enter {selected go to what option} box is empty.

	Close
	Closes the Find and Replace dialog box.  The Find and Replace dialog box stays open until you close it.


Finding and Replacing Text

Finding Text XE "Finding Text" 
To search for text:

1. Click on the Edit menu and click on Find (OR you can press Ctrl/F keys) to display the Find and Replace Window.
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2. Click on the More button and the following window is open.

	Options available with the More selection

in the Find and Replace window

	Option
	Description

	Find what
	Allows you to enter the text that you want to find.

	Less/More
	Allows you to collapse the window so it takes up less screen space or expand the window so more options are available.

	Find Next
	Allows you to begin the search to find the first occurrence of the character sequence, or to go to the next occurrence by selecting Find Next again.

	Cancel
	Cancels the search, closes the window, and returns you to your document.

	Search
	Specifies that you want to search from the insertion point Down to the end of the document, from the insertion point Up to the start of the document, or All of the text in the document.

	Match case
	Allows you to exactly match a pattern of uppercase and lowercase letters when looking for a word or phrase.  For instance, if you enter marine, Word would not find Marine.

	Find whole words only
	Finds the word you indicate in the form of a whole word only.  If you were searching for the word ring, Word would not find sharing or ringing.

	Use wildcards
	Allows you to use special search characters.  Select Use wildcards and then type a wildcard character or select a character from the Special list. For instance, if you look on the Special list, you see that * (asterisk or star) represents zero or more characters.  You can, therefore, enter c*r to find computer, car, or calendar.  Use wildcards option is case-sensitive.

	Sounds like
	Finds words that sound like, but are spelled differently than, the word you enter.  For instance, if you select this option and enter to, Word would find two.

	Find all word forms
	Allows you to locate different tenses of the same word, if you selected this option when you installed Word.  For example, if you select this option and enter see, Word locates see, seen and saw.  If you select this option Word automatically clears the Match case and Find whole words only option.

	Format
	Finds text with special character or paragraph formatting, text in a particular language, or text formatted with a particular style.  Select the option you want from the Format list and then select the appropriate formats from the window that Word displays.

	Special
	Finds special characters that do not appear on the keyboard or that serve as search characters.

	No formatting
	Tells Word not to consider formatting when searching for the text.  By default, the No formatting option is selected and is therefore, not available unless you have specified formatting and then want to change back to no formatting.


3.
Type the word or character sequence you are searching for in the Find what box.

4.
Select any options you want.

5.
Click on Find Next.

6.
To go to the next occurrence of the text for which you are searching, click on Find Next.
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7.
Click on OK to return to the Find and Replace window.  

8.
Click on the Close button to close the Find and Replace window.
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NOTE:  The options you select in the Find and Replace dialog box affects the function of the Previous Page and Next Page buttons on the vertical scroll bar.  They turn blue and continue searching for what you had in your Find What: field.  To return to the Previous Page and Next Page functions, click on the Select Browse Object Button and click on the Browse by Page Icon in the lower right-hand of your screen.

Replacing Text XE "Replacing Text" 
You can find particular text and replace it with new text.  The procedures and available options for replacing text are similar to those for finding text.
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To replace text, use the following steps:

1.
Click on the Edit menu.

2.
Click on Replace.


3.
Type the word or character sequence you are searching for in the Find what field.

4.
Press Tab or click in the Replace with field.

5.
Type the replacement text in the Replace with field.

6.
Do one of the following:

· Click on Find Next to stop at every occurrence of the Find what text so you can then decide whether to replace it, and click on Replace when appropriate.


· OR Click on Replace All to automatically replace all occurrences of the Find what text.

Word replaces the indicated text with the replacement text.
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When Word finishes the search, it displays the following dialog box:

If you selected the Replace All option, the above dialog box indicates the total number of replacements made in your document.

7.
Click on OK to return to the Find and Replace dialog box.

8.
Click on Close or Cancel.
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NOTE:  The options you select in the Find and Replace dialog box affects the function of the Previous Page and Next Page buttons on the vertical scroll bar.  They turn blue and continue searching for what you had in your Find What: field.  To return to the Previous Page and Next Page functions, click on the Select Browse Object Button and click on the Browse by Page Icon in the lower right-hand of your screen.

Exit XE "Exit" 
Click File/Exit 

[image: image79.png]cument5

rosoft Word =18]x]
| Fle Edt iew Insett Tooks Fomat Toos Table Window Help i &b H Today
DeEagRY|iaRI - |8

| N

o o ot 12| B 2 U

[

2]
N [of
|
ofs]z]«| >
[Page 1 sect W Jmer ni Gar e i e o | G
Bston | (2] @ 3 |) Finbo - Micsot... | M 0BT Teacker- 0. |[EiDoouments - Bhoving s 2000..| [BZ BB 24P





OR 
click on the      in the upper right-hand corner.
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